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Overview 

This document covers the new features introduced in the 2015 Release of Impact. Many of these 
features can be utilised out-of-the-box; however, several may require configuration changes, i.e., 
where an existing installation is to be upgraded. Such features are identified throughout this 
document by an asterisk (*). Certain features were introduced towards the end of the Impact 2015 
life-cycle. Such features are identified throughout this document by twin asterisks (**). Not all of the 
features described within this document are applicable to all Impact licenses. Please consult Arden 
Software for further details. 
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3D Performance 

Significant performance improvements have been made, regarding the loading, displaying & saving 
of 3D layers.   
 

Delayed Loading of Textures 

In Impact versions up to & including Impact 2014, Impact will not display a 3D scene until all the 
textures for that scene (board materials, artwork textures & occlusion textures for ‘TruView’ effects) 
have been loaded.  This lead to ‘dead-time’ (Impact is unresponsive whilst waiting for the textures to 
load) whilst Impact was loading the textures.   
 
New options (Delayed Loading of Textures) have been added to delay the loading of textures into a 
3D scene.  This has the effect of allowing Impact to draw a folding model instantly (once the drawing 
itself has been loaded) and to load the textures once the model has been drawn. The benefit is that 
the 3D layer may be manipulated (Pan/Zoom or Rotate View etc) as soon as the folding model is 
drawn, and ‘dead-time’ is virtually eliminated.  This technique is applied to viewing 3D layers within 
the Projects Browser, as well as editing a 3D layer and switching between 2D & 3D layers.  Delayed 
loading of textures is optional (users who don’t make use of large/advanced textures or complex 3D 
scenes can switch this feature off, if required) and is also configurable.   
 
 

  

   Fig 1 – Delayed Texture Loading Options 

Target Load Rate – allows you to specify the number of textures Impact will attempt to load, per 
second (assuming the textures load instantly).  Setting a low value (such as 1), would instruct Impact 
to try to load one texture map per second (which would lead to a very gradual load-in of textures 
but an instant display of a folding model).  A high value (such as 100) would then instruct Impact to 
attempt to load 100 texture maps, per second (effectively all the textures within a 3D scene) – which 
would lead to a quicker attempted load of textures, though a slightly delayed display of a folding 
model. 
 
Texture Size Limit – allows you to specify the size of textures (once in memory, not on disk!) which 
will be subjected to delayed loading.   
 
A value of 1MB would mean that all textures under 1MB (which should be manageable for most 
hardware setups) would be not subject to delayed loading, and Impact would attempt to load them 
instantly.  This would allow a folding model to be displayed very quickly, followed by the delayed 
loading of all textures over 1MB in size.   
 
A value of 100MB would mean that textures of under 100MB would not be subjected to delayed 
loading – and so Impact would attempt to load them instantly.  This would (in all likelihood) lead to a 
significant delay (and ‘dead-time) whilst Impact is attempting to load some very large textures. 
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Load by Default – will allow you to choose a texture type which is not subject to delayed loading.   
 
Choose from:  
 

 None - don’t load any textures by default, and therefore subject all textures to delayed-
loading.  This will allow for the quickest display of a folding model, displaying a simple white 
texture, after which the base (material) textures will be delay-loaded, followed by delay-
loaded artwork textures.. 

 

 Base textures - don’t apply delayed loading to base (ie material) textures.  Impact will 
attempt to load the material textures instantly, followed by the delay-loaded artwork 
textures.   As the base textures are not usually the primary cause of a performance-hit, this 
is a usually good compromise.  The model will be displayed quickly, with the material 
textures, whilst the artwork is then delay-loaded. 

 

 Base and artwork textures – do not apply delayed-loading to either texture type.  This 
allows for a quick display of the folding model but the textures would not be subject to 
delayed-loading.  This would mean that although the model is displayed, Impact would be 
unresponsive until all the textures have been loaded. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Composite Textures  

Impact creates large composite textures for 3D scenes – to allow backwards compatibility with old 
(ie Impact 5.1 and earlier) versions of the Impact application.  For Impact 2015, we have ceased to 
do this – instead, composite textures are created solely on export to the Impact (*.ipd) file format, 
and only when the following option is enabled: 
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   Fig 2 – Export composite textures 

This option will be unchecked for an upgrade to Impact 2015.  Simply opening & saving an existing 
drawing in Impact 2015 will remove the composite textures from a 3D scene, resulting in a 
decreased file size and providing a performance improvement. 
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Utilise OpenGL3 Extensions 

In Impact 2015, Shaders are now cached for an entire Impact session, after their first use.  This 
provides an additional performance boost when displaying 3D layers.  Newer integrated Intel 
graphics setups may struggle with this feature, so this is also an optional feature within the 
Advanced 3D Settings: 
 
 

 

   Fig 3 – Accelerate Shaders option 

The recommendation (when using integrated graphics setups) is to disable this option.  On an 
upgrade to Impact 2015, this option will checked (enabled) by default. 

 
Transparency Flagging 

Whenever a project containing 3D layers is opened, Impact searches through each texture to identify 
textures which feature transparency.  In Impact 2015, Impact stores a flag within the drawing to 
indicate whether or not the textures contain transparency.  Therefore, we have eliminated 
unnecessary searching, resulting in a performance boost.  This development is strictly internal, with 
nothing to configure. 
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Display of Total Texture Sizes 

As an aid to fault-finding & benchmarking, Impact 2015 has the ability to display the size of all 
textures within a 3D scene.  The total texture size is now displayed within the Texture Manager: 
 

 

Fig 4 – Total Texture Size 
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Framerate Display 

Another benchmarking feature has been added – the ability to display framerates within a 3D scene.  
This is a new option within the 3D Visibility options. 
 

 
  

Fig 5 – Show Frames per Second option 

 
The details will be displayed in the bottom-left corner of the 3D scene, using the user-defined 3D 
Text colour: 
 

 

Fig 6 – Frames Per Second Display 
 

Additional Debug Logging 

Yet another benchmarking feature - the debug.log file now lists previously-hidden textures (and 
their sizes) plus overall texture-load times.  This is not an optional feature and requires no 
enabling/configuration: 
 
2015:01:16 13:25:32:854 TMaterial::GetTexture - Loading texture 'Artwork Texture (base)_1' with size 13729792 bytes. 
2015:01:16 13:25:33:499 TMaterial::GetTexture - Loading texture 'Occlusion Texture (base)_2' with size 4194304 bytes. 
2015:01:16 13:25:33:558 TMaterial::GetTexture - Loading texture 'Mask Texture (base)_1' with size 4 bytes. 
2015:01:16 13:25:33:564 TMaterial::GetTexture - Loading texture 'Occlusion Texture (base)_3' with size 4194304 bytes. 
2015:01:16 13:25:33:628 TMaterial::GetTexture - Loading texture 'Occlusion Texture (base fitting)_3' with size 4194304 bytes. 
2015:01:16 13:25:33:731 TMaterial::GetTexture - Loading texture 'Occlusion Texture (base fitting)_2' with size 4194304 bytes. 
2015:01:16 13:25:33:801 TMaterial::GetTexture - Loading texture 'Mask Texture (base fitting)_1' with size 4 bytes. 
2015:01:16 13:25:33:809 TMaterial::GetTexture - Loading texture 'Occlusion Texture (GLASS OUTER)_3' with size 4194304 bytes. 
2015:01:16 13:25:33:867 TMaterial::GetTexture - Loading texture 'Occlusion Texture (GLASS OUTER)_2' with size 4194304 bytes. 
015:01:16 13:25:40:500 TMultiWin::OnLoadingTimer - Texture load timer. 
2015:01:16 13:25:40:514 TMultiWin::OnLoadingTimer - Texture delay loading completed in 8486 milliseconds. 

Fig 7 – Additional Debug Log Entries 
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3D Environment 

Workstation Options 

As the 3D Renderer settings (Automatic Degradation, Texture Mapping, Advanced (and the new 
Delayed Texture Loading options)) have always been workstation-specific , they have been moved 
from View>Visibility (and 3D context menu>Visibility) to a new 3D Branch within 
Options>Environment>Workstation: 
 

 
 

Fig 8 – 3D Settings within Workstation Options 
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Colour Coding of 3D Centre Snaps 

 
Following on from the colour-coding of 3D Snaps in Impact 2013 R2, centre-snaps can now be 
colour-coded (previously they used the same colouration as mid-point snaps): 
 
 

 
 

Fig 9 – Colour Coding for 3D Centre-Snaps 
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3D Hardware 

 
Impact 2015 now supports 3D Connexion’s Space Mouse/Space Pilot  devices: 
 

 

Fig 10 – 3D Connexion Devices 

The Space Mouse/Space Pilot devices are to be used by your non-dominant hand, providing pan, 
zoom & rotate controls, whilst the dominant hand is free to run other tools within a 3D scene (such 
as 3DMove, 3DObjectRotate, Dimension Aligned, EnquireDistance2Points). 
 
The devices are often configurable, allowing you to assign Impact tools to mouse buttons via a 
simple desktop application: 
 

 
 

Fig 11 – Typical 3D Connexion Button Options 
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3D Animation  

 

Animation Looping 

Following on from the animation frame copy/paste/mirror options added to Impact 2014, it is now 
possible to loop a selected range of keyframes.  Simply click & drag the time line to create the 
selection and the play controls (First Frame/Previous Frame/Play in Reverse/Play/Next Frame/Last 
Frame) will respect the selected range of frames. 
 
 

 

Fig 12 – Looped Animation Frames 

 
Simply double-click the time-line to cancel the selection. 
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Keyboard Shortcut for Goto Frame 

The 3D Animation Goto Frame feature (which was added to the Animation Editor for Impact 2014): 
 

 
 

Fig 13 – Hotkey Assignment for 3D Animation Goto Frame 

 
may now be assigned to a user-defined hotkey, providing further speed improvements when 
creating/editing animations. 
 

 

Fig 14 – Hotkey Assignment for 3D Animation Goto Frame 
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Improved Keyboard Shortcuts 

Superfluous (and possibly confusing) keyboard shortcuts have been removed, leaving a clearer set of 
possible assignments. 
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3D Import & Export 

Animated PDF/U3D Exports 

Impact 2015 is now able to produce animated 3D PDF & U3D files.  Create your animation as normal 
and simply export to the Adobe PDF or U3D formats (there are no additional settings needed to 
facilitate the export of animation frames).   
 

 
 
Animated PDF offers several advantages over WRL (Virtual Reality Modelling Language) and AVI 
(Audi Video Interleave) animations.  Reduced file size (and so easier distribution) is one significant 
benefit.  The fact that most desktops/laptops are pre-installed with the requisite version of Adobe 
Reader (so that no further downloads/plugins are required) is another benefit.   Note that there is a 
known issue with Adobe Reader which prevents the automatic update of animated camera frames.  
Face-folding & object movement/rotation frames are unaffected by this. 



 Version: 1.1 | 14/11/2014 Arden Software Ltd 
 

 What's New in Impact 2015 Page 18 | 50 
 

Improved PDF/U3D Lighting 

3D PDF/U3D Exports from Impact 2015 now contain a better approximation of 3D scene lighting 
than previously.  You no longer have to apply the “Bright Lights” setting within Adobe Reader. 
 

  
 

Fig 15 – 3D PDF Exports from Impact 2014 (left) and Impact 2015 (right) 

 
There are no Impact changes necessary (or settings to configure), in order to benefit from this 
improvement. 
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Export of Acetates to the 3D PDF/U3D Formats 

Another 3D PDF/U3D improvement which requires no changes to settings or workflow is the export 
of acetates/window patches to the Adobe PDF/U3D formats. 
 

 

Fig 16 – 3D PDF Acetate Window Patch 
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Environmental Reflections in the 3D PDF/U3D Formats 

An additional 3D PDF/U3D improvement requiring no changes is the export of environmental 
reflections: 
 
 

 
 

Fig 17 – 3D PDF Export with Environmental Reflections 

Instancing of 3D PDF/U3D Exports 

When exporting an array of objects to the PDF/U3D formats, Impact 2015 will create ‘instances’ of 
the models, so that instead of a 20-unit array of a 5MB model creating a 100MB 3D PDF file, Impact 
2015 will create a 5MB 3D PDF, containing the entire 20-unit array.  As with the previous PDF/U3D 
exports, no workflow or settings changes are needed to benefit from this enhancement.  This is 
especially effective when exporting arrays of imported solid objects. 
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Hoops Library/3DX Update 

A new version of the Impact 3DX library has been issued (v1.5) – and with it come updates to the 
supported file formats: 
 

 Parasolid – support for version v26.0 has been added 

 Solid Edge – support for version ST7 has been added. 

 SolidWorks – support for version 2014 has been added. 

 STEP – support for version AP 242 has been added. 

 Siemens PLM NX Software – support for version 9.0 has been added. 

 Autodesk Inventor – support for version 2015 has been added. 

 CATIA V5-6 – support for version 2014 has been added. 

 Creo – support for Parametric version 3.0 has been added. 

 
In addition, the Solid Edge reader now imports welding & frame data; the IFC reader features 
improved load time with many files and the Rhino reader now supports external file references. 
 

Align to Plane/Ground 

A new Edit Bar option has been to the 3D Align tool in Impact 2015.  “Align selected”. 
 

 

Fig  – New Align Selected option for 3D Align tool  

 
When enabled, all selected objects may be aligned to a single face/plane.  Consider a complex 3D 
object containing sub-assemblies/sub-models, which do not form groups (or a parent/child 
hierarchy).    The new option will allow the all the selected objects to be aligned to a single face or 
plane, whilst still preserving the ability to move or rotate the individual objects. 
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Automation/COM 

Impact 2015 COM enhancements focussed upon performance improvements, enhancing the ability 
to create shapes and providing interfaces to the new Document Management suite.  All the Impact 
2015 COM interfaces are described in the Impact COM Documentation, available on request. 

Improve Performance by Limiting Canvas Redraws 

 

Two new IApplication methods have been added – app.BeginBatch() and app.EndBatch().   
 
These methods disable & enable canvas redrawing, which can lead to a significant performance 
boost. 
 
 
A new IActiveBlock method has been added - activeblock.Select( entitiesCollection, 
selectStateBoolean ) 

 
Additional IShape features 

 

The ability to create & manipulate closed shapes has been enhanced by the addition of two new 
modes to IShapeCreator.Perform (creation mode) – Points and Holes; whilst a new IShape method 
has been added - shape.Extents() 
 

Document Management 

To complement the new Document Management functionality, a new object (IDocument) has been 
created, with many new methods & properties – including: 
 
IDocumentColumn, IDocumentColumn IDocumentColumns, IDocumentContext, 
IDocumentCreator, IDocumentCreatorDocument, IDocumentCreatorRelationship, 
IDocumentCriterion, IDocumentExtender, IDocumentGroup, IDocumentGroups, 
IDocumentHistory, IDocumentMetaExtrator, IDocumentMetaExtractors, IDocumentMIMEType, 
IDocumentMIMETypes, IDocumentProvider, IDocumentRelationship 
 
and many others… 
 
 
 Additional Document properties have been added -  ICustomerContact, IDatabaseLayer, ISite, IUser 
and IDatabaseItem. 
 
 
All the Impact COM interfaces are described in the Impact COM Documentation, available on 
request. 
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IAP Installation by Drag & Drop 

Impact Auto-Plugins (IAPs) can now be installed by simply dragging & dropping the IAP onto the 
Impact canvas, as opposed to manually placing the IAP within the defined Plugins folder. 

Blocks 

Block Rename - Block Inspector Consolidation 

The block rename tool now allows you to rename all selected blocks to the same root name. If for 
example you have a layer with blocks named: cutout_1, cutout_2, cutout_4 this function would 
allow you to quickly rename all the selected bocks to have a continuous _number sequence. This 
function has also been added to the block inspector. 
 

 

Fig – Block Inspector rename  

 

 

Fig – Block rename multiple selected blocks  
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Running the block rename tool when you don’t have any blocks selected opens the block rename 
dialog as previous versions of Impact. 
 

 

Fig – Block rename without any selected blocks 

 
 

Block Styles - Block Inspector Consolidation 

The block change style tool has been added to the block inspector. 

Block Order – Block Inspector 

The block inspector lists the blocks in alphanumerical order rather than alphabetical order i.e. 
'MyBlock_10' appears after 'MyBlock_9' rather than after 'MyBlock_1'. 
 
The order the blocks are stored in the drawing are displayed in the block inspector and the order of 
these can be now be changed simply by dragging and dropping selected entries or by pre-defined 
conditions of the name, style or first palette. 
 

 

Fig – Block Inspector reordering 
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Diemaking General 

Restart of Tools (Flatbed & Rotary Diemaking) 

Following on from the Impact 2014 Stripper & Layout enhancements, Diemaking session  data is now 
stored within the drawing itself.  This means that it is now possible to quit & restart the Diemaking 
tools without the need to delete all of the existing Dieboard geometry and ‘start from scratch’.   
 

  

Fig – Diemaking Session Restart/Continue Editing Options 

The session data may also be deleted via the Layer Properties dialog: 
 

 

Fig – Diemaking Session Data Icon within Layer Properties Dialog 

 

Running Diemaking Tools on a Locked Layer/Markup Layers 

There may be occasions when Diemakers wish to be able to run tools (such as Rubber Creator, 
Matrix Creator, Stripper Creator) on layers which may be ‘locked’ (checked-out) by other users. 
 
To remedy this, Impact 2015 introduces the concept of a Markup Layer – a new layer type, 
containing an insert of the original drawing layer.  Markup Layers may be created at any time - via 
the context menu on the Drawings Hierarchy or the Layer Tabs:  
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Fig – Manually Creating a Markup Layer via Layer Tabs 

 
 

 
 

Fig – Manually Creating a Markup Layer via Drawings Hierarchy 

 
 

 
 

Fig – Markup Layer Tab 

 
 
Most significantly, Markup Layers can be created automatically  when a the Dieboard Creator, 
Rotary Dieboard Creator, Rubber Creator, Blanker Creator, Matrix Creator tools are executed on a 
‘locked’ layer: 
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Fig – Automatic Creation of Markup Layer  

 
Note that Markup Layers will not display the Layer Properties dialog and the Plot tools have been 
disabled. 
 
The concept of Markup Layers can also be used to annotate a layer without making any changes to 
the drawing. 

Diemaking Blanker 

 

Improved Workflow 

There have been several workflow enhancements to the blanker tool with the new shortcut keys for 
edit, copy and delete. In previous versions of Impact you had to manually complete some tools 
before allowing you to start a new tool, for example the fillet tool, these restraints have been 
removed. 
 

Jogger Alignment 

The symbol placement tool now allows you to place joggers on the opposite side of the frame to the 
one being placed and where this is not required you can add a construction line allowing alignment 
of drop and internal joggers. Where possible you would place joggers in line to optimise the areas 
for light beams and non-stop bars. 
The symbol placement tool now defaults to the place symbol mode and not the select symbol mode. 
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Fig – Jogger alignment and construction lines 

 

Bar Clamp Position 

With Impact you can automatically add the clamps to lock the bars to the frame, the default position 
of these can now lock to the side of the bar as well as the centre. This option now allows for the 
automatic placement for clamps that lock to the side of the bar of any width as with systems such as 
the BSI quick lock system. 
 

 
 

Fig – Bar clamps positioned to the side of any width bar 

 
 

Copy Section of a Bar 

Creating lower frame bar on a multiple layout can require intricate profiling which is often repeated 
across the length of a bar, to ensure the bends are kept the same you can now copy a bent section 
of a bar to replicated areas. 
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Fig – Copying a bent section of a blanker bar 

 

Upper Pin Placement 

The option to rotate upper support pins has been added to aid the placement of different styles. 
 
 

 
 

Fig – Placement of upper location pins can be rotated 
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Diemaking Rotary 

 
The Rotary Dieboard has had some significant enhancements added to Impact 2015.  
 

Cylinder 

The concept of the cylinder has been added, this then allows the relationship between the shells, 
design and cylinder to be clearly visualised. The cylinder parameters are used to calculate the print 
repeat value which can then be used to determine the linear spacing for the mounting bolts (see 
symbol pattern changes) 
 

 

Fig – Rotary cylinder 

Cylinder Positioning 

The default placement of the design and the shells on the cylinder can now be set for each machine.  
The option to place the design on the cylinder by: 

 Centre crease – centre cylinder 

 Centre design – centre cylinder 

 First crease – offset from edge of the cylinder 
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Fig – Cylinder settings page from the MTS 

 

 
 

Fig – Design positioned relative to the first crease 

Shells 

The diemaker may stock more than one shell length per cylinder diameter, for example 1m, 1.5m 
and 2m lengths. These lengths can be added to the settings allowing the optimal number across the 
cylinder default when applying the Rotary Dieboard. 

 

Symbol Pattern Placement 

Two new options have been added to aid the placement of standard parts, symbol patterns can now 
be placed relative to the cylinder or relative to each shell. Bolt symbols placed relative to the 
cylinder have the option for automatic selection based on a grid, for example every 5th bolt along 
and around. The ability to place a pattern relative to each shell allows automatic placement of parts 
such as lead or trail edge markers on all the shells.  
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Woodsize 

The option to check the woodsize before creation has been moved to an edit bar mode, replacing 
the pop up window and making it consistent with the other editing modes. This then allows the user 
to change the calculated size quickly if they know for example a reducing the size would reduce the 
number of shells. In this mode the shells extents are shown on the design so any changes can be 
seen before being applied. 
 

 
 

 

Editing  

The size of the overall wood or individual shells can be modified interactively using the edit mode 
shells. This mode allows the sides of the wood or any split lines to be repositioned by dragging and 
repositioning or by editing the shell values on the edit bar. 
 

 
 

Fig  – Shells mode edit bar 

 
The mode cylinder position allows the user to move the cylinder and the dieboard relative to design 
if required. This is useful if the design needs moving slightly to ensure enough bolt positions are 
available for mounting. 
 

Mounting Holes 

The edit bar mode place mounting holes shows all the possible positions for a mounting including 
the default selection grid. In this mode the user can quickly toggle which mounting bolts on the 
cylinder are to be added to the dieboard. 
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Fig  - Mounting hole editing 

 
 

Rotary Split  

The Rotary Split separates the rotary dieboard into separate shells for laser output. In Impact 2015 
the option to create the separated shells into a new layer has been added whereas previous version 
changed the dieboard geometry in the active layer.  
 
 

 
 

Fig  - Rotary Split output to new layer MTS 

Editing Tools 

Quick Explode Tool 

Whilst the Explode tool provides options for exploding any number of entities & entity types (Blocks 
to entities, Symbols to blocks, Text to lines, Arcs to lines/arc segments/quad segments, Beziers to 
arcs & lines/Dimensions to lines etc), the complex nature of exploding a wide-range of objects 
necessitates a large & complex dialog box to contain all the various options & combinations.  The 
Quick Explode tool in Impact 2015 provides a quick & easy explode option, without the dialog box.  
The tool is also the first example of a widely-used scripted solution being incorporated into core 
Impact functionality. 
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Fig  – Quick Explode tool 

 
 

 

Fig  – Edit Bar Options for the Quick Explode tool 

 
Initial Edit Bar options: 
 

 Arcs to quad segments – arcs are split at their quadrant boundaries. Unchecking this option 
will then display the following arc options: 

 

o Maximum lines from an arc – specifies the maximum number of line entities into 
which the arc can be explode. 

 

o Arc tolerance – specifies the maximum distance of the new lines from the original 
arc. A tolerance value of zero causes the tool to use its default tolerance value. 

 
 

 Special text – text entities containing special text (such as items calculated from system 
functions, database fields, macros and so on) are converted into normal fixed text. 

 

 Palette composition – entities that are assigned palettes with a rule type other than Normal 
(such as Combination or Zipper) will be divided into entities matching the manufacturing 
information pattern.  For example, a single cut/crease line will be broken into sections of cut 
line and crease line. 

 

 Bridges – entities containing bridges will be divided into individual entities between each 
bridge. 

 
1-2-1 Bridge Format – entities containing bridges which do not conform to the 1-2-1 format are split 
into smaller entities which do. Unlike the Bridged Entities explode method, these new entities are 
end-to-end and can therefore be rejoined. This method is often used when exporting the data to 
another system which only supports 1-2-1 bridging. 
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 Selection – chose from Select New (to leave the exploded entities selected) and Select None 
(to leave the exploded entities unselected) 

 

 All Selected – performs the explode function on all selected entities.  

 
Running the tool and clicking on an entity will explode that entity down to its default components. 
For example, clicking on a Bezier will break the Bezier down into its arc and line components. This is 
shown by the entity becoming selected, and a small circle marker generated for the new entity. You 
can keep clicking this way to break individual entities down further. 
 
If the tool is activated with multiple entities selected, the behaviour of the tool is modified slightly - 
clicking on one of the selected entities (or the 'All selected' button) will explode all of the selected 
entities, but only from the highest entity type. Note that the tool gives entity types a priority, in the 
following order: 
 
SYMBOLS 
BLOCKS 
DIMENSIONS 
SPECIAL TEXT* 
TEXT 
PALETTES* 
BRIDGES* 
BEZIERS 
ARCS 
LINES 
 
* Only exploded if the respective toolbar switches are enabled. 
 
 
Clicking an entity whilst many are currently selected will deselect them, and explode the single entity 
as first described.   
 
 
 
 

Geometry Tools 

Anti-Flicker 

The Double Buffering display setting (found in Impact 2014 and earlier) has been replaced by a new 
Anti-Flicker control.  This feature enhances the Double-Buffering mechanism, to optimise the 
drawing of “cursors” (for example when inserting a symbol or symbol pattern, or pasting geometry).  
The flicker effect when moving a complex “cursor” (typically when there are many symbols or 
entities to be placed) has now been eliminated.  This allows the “cursor” content to be placed 
significantly faster & more accurately than ever before.   After upgrading to Impact 2015 (and also 
upon switching Appearance Settings), the following dialog is displayed: 
 



 Version: 1.1 | 14/11/2014 Arden Software Ltd 
 

 What's New in Impact 2015 Page 36 | 50 
 

 

Fig – Anti-Flicker Message upon Login/Loading of Appearance Settings 

 
 The Anti-Flicker control has been added to the Display options, found within 
Options>Environment>Display>Drawing Canvases: 
 

            

Fig – Anti-Flicker Control  

Bezier Pen  

A new Bezier tool Draw > Bezier > Pen has been developed for Impact 2015. This is intended to 
replace the Draw> Bezier> Path tool (which has been added to the “Legacy” tool category) by 
providing additional functionality & flexibility.   
 

 
Fig – Bezier Pen tool 
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Click the first point, then click-and-drag subsequent points (or just click to create straight segments) 
and finish with a click. On cancelling the tool, the segments are used to generate Bezier entities (or 
optionally line entities, for straight segments).  
 
Edit Bar options:  

 Rewind – to “undo” the last operation  

 Forward – to “redo” the next operation (if there is one)  

 Lines – causes straight segments to generate line entities, when the tool is finishing  
 

 
 

   Fig – Edit Bar Options for Bezier Pen 

Node markers are drawn at the ends of each segment – these can be repositioned with a click-and-
drag (but only when “handlebars” are not displayed). Similarly the “handlebars” can be displayed by 
clicking on a node – the bars can then be repositioned by click-and-dragging on the bar ends.  
 
Right-click on any node marker for the following functions:  
 

 Asymmetric Node – makes the “handlebars” move independently (different lengths, 
opposite direction)  

 Symmetric Node – makes the “handlebars” move together (same length, opposite direction)  

 Cusp Node – makes the “handlebars” move independently (different lengths, different 
directions)  

 Node To Lines – makes the “handlebars” zero length, “flattening” the curves either side of 
the node  

 Line Before – “flattens” the segment before the node  

 Line After – “flattens” the segment after the node  

 Curve Before – “unflattens” the segment before the node  
 
 
 

Import Export 

Add additional settings for DWG/COLLADA export* 

Options to export textures and warnings regarding target cameras have been added to the 
COLLADA/Packaged COLLADA and DWG export settings: 
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Fig – COLLADA/Packaged COLLADA and DWG 3D Export Master Tool Settings 

 
 

 
 
 
PDF Overprinting 
 
Impact 2015 now offers the ability to enable overprinting when exporting to the PDF format - 
preventing artwork knock-outs when palette spot colours are hidden (typically when an Impact-
generated PDF file is used within a graphics workflow). 
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Fig – Artwork Knock-Outs (No Overprinting) 

 

Fig – No Artwork Knock-Outs (Overprinting) 

PDF Export in CMYK 

Impact 2015 now offers the ability to export to the PDF format using RGB or CMYK colour modes. 
 

 

Fig – RGB/CMYK Colour Mode options 
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Consolidation of PDF/PS/AI Export Settings 

 
The Adobe Export Settings branch for Impact 2014 (and previous) contained identical nodes for the 
PDF, PS and AI formats, and offered many controls which affected the PDF format only. As such, 
many of the options were superfluous and the dialog as a whole was confusing.  The export settings 
for Impact 2015 have been modified and now contain only valid options which affect the relevant 
file formats. 
 
 

 
 

Fig – Adobe Illustrator Export Branch 
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Fig – Adobe PDF Export Branch 
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Fig – Adobe PostScript Export Branch 

Note that the Import settings for the Adobe formats remain untouched. 

RGB - CMYK conversion in Import/Export settings 

The calculation of values for RGB>CMYK conversions (and vice-versa) within the Import/Export 
Settings now use the correct formulae.  Because of this, exports to the Adobe formats (using existing 
Import/Export Settings) may look slightly different, following an upgrade to Impact 2015. 

Enhanced Import/Export Dialog Boxes  

New options for Browse/Hide Folders, Open file after publishing and Open folder after publishing 
have been added to the 2D Export, 3D Snapshot, Send to Graphics File, Save (Image) As dialogs: 
 

 
 

Fig – Enhanced Export Dialog 
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Similarly, the 2D Import dialog has also been enhanced with new options for displaying a Preview 
window and Show previous versions of the selected file: 
 

 

Fig – Enhanced Import Dialog 

Installers 

Remove Support for Win 2K/Win XP 

As of April 8, 2014, Microsoft's support for Windows XP ended.  Therefore, Impact 2015 will be the 
first major version that will not be compatible with this operating system.   However, Windows 
Vista and above will continue to be supported. 
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Layouts 

 

Add All Favourite Stock Sheet Settings to Layout Sheet Assistant 

Impact 2015 now makes it possible to add all your ‘Favourite’ Stock Sheet Master Tool Settings to 
the Layout Sheet Assistant with a single click.  If you can make use of pre-cut board/stock sheets, 
this can save time when creating/estimating layouts across multiple sheets.   
 

 
  

Fig  – Add All Favourites option within the Layout Sheet Assistant 
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Document Management 

Consistent/Improved Document Management 

Impact 2015 features a completely rewritten document management system, with many new 
features.  Some of the most significant developments include drag & drop addition of single (or 
multiple) documents, document tagging, one-to-many relationships (allowing a single document to 
be referenced by multiple Impact projects or customers), document thumbnails (where 
appropriate), document searching, document metadata support and at-a-glance document history.  
Additionally, Impact 2015 is able to integrate with 3rd-party document management systems. 
 
 

 

Fig  – Document Management Interface 

 

Rule Preparation 

Split and merge rule prep blocks 

A rule preparation block is a path for a single piece of rule for output to the rule processor.  
 
Once a ruled block has been created the block it can then be split at a picked point to create a join if 
needed. Similar the option to join two rule blocks into one has been added with the merge tool.  
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Fig  –  Single rule block split at a picked point 

 

Automatically set the end conditions 

Previous versions of Impact have a mode for the automatic creation of all crease entities where the 
end conditions are automatically calculated. In Impact 2015 there is an option to automatically 
calculate the end conditions of manually created paths.  

Coincident ends  
Applies end condition of 0 +/- the adjust value. 
 

 

 

Fig – Example of a coincident join 

Ends in space 
 
Applies end condition of 0mm +/- the adjust value to any ends in space. 

Intersecting 
 
Where the end of a defined path intersects with another ruled block but the ends are not a corner or 
collinear the correct calculated value will be applied. 
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Clear visualisation 

The visualisation of top notches and freegrind is much clearer showing the width and the size for top 
notches. It is also possible to define the colours for the different top notches – crease and 
perforation. 
 

 

Fig – Freegrind position 

Improve support of top notches in the Rule Prep tool 

Top notches on a ruled path can be either for nicks, perforation or crease within a cut-crease path. It 
is now possible in Impact 2015 to automatically detect nick symbols and crease combinations as well 
as perforations to create the correct width top notches along a path. 
 

 

Fig – MTS for automatic creation of top notches 

Shortcut Keys 

Extra shortcut keys have been added to improve the workflow, these include edit block, breaks, split 
and merge. 
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Selection Tools 

Select by Example Tool 

 
A new selection tool has been developed for Impact 2015 - Select by Example.  This is another 
example of a widely-used script-based solution becoming core Impact functionality.  The tool allows 
a selection to be made, based on the properties of a picked block or entity.   
 
 

 

Fig – Select by Example tool 

Edit-Bar options are provided to enable filtering by Length, Radius & Sweep.  When enabled, entities 
within the specified Length/Radius/Sweep tolerances of the picked entity will be selected.  An option 
for filtering by Palette is also available.  If the palette filter is enabled, only entities matching the 
palette of the picked entity will be selected. 
 

 

Fig – Edit Bar Options for Select by Example tool 

Symbol Patterns 

Create Symbol Pattern from a Layer with Inserted Symbols 

The Block>Create Symbol Pattern tool previously allowed you to create a symbol pattern using 
circles in the drawing, and replacing them all with the same symbol. Impact 2015 adds the ability to 
use the inserted symbols within a drawing, in order to create a pattern.  Each separate symbol will 
then be added to the symbol pattern, relative to a single reference point.  This can make creating 
symbol patterns for the dieboard tools significantly quicker than before.  There are no changes to 
any dialog boxes or settings needed in order to benefit from this enhancement. 
 

Rotary Mounting using Radial values 

Symbol patterns are used for automatic placement of standard parts by several diemaking tools in 
Impact. For the Rotary Dieboard tool there is an option to place the symbols using radial values for 
the cylinder mounting systems. This new feature means the same bolt mounting system can be used 
for different print repeat parameters. 
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Fig – Symbol placement using radial values 

 

Replacement Collision Symbols 

 
Symbol patterns have the option to check if any symbols collide with existing geometry and prevent 
placement of these parts. This is a useful feature for example when placing the mounting holes for a 
flatbed dieboard. In Impact 2015 there is now the option to place an alternative symbol if the active 
symbol collides with any entities. 
 

 
 

Fig – Symbol pattern alternative symbol placement 
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Fig – Alternative symbol placed where the original collided 
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